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 High Plains REC Has Moved! 
 

In November, High Plains Regional Education Cooperative (HPREC) moved from 
a 5,000 square foot historical building, nestled on South First Street, to a large, 
spacious facility on North Second Street in downtown Raton. HPREC has 
transformed the old Bank of America building into a comprehensive educational 
agency that will more effectively meet the diverse needs of schools in 
northeastern New Mexico. With over 14,000 square feet, the new facility is 
comprised of a new training center (accommodating over 60 participants), a large 
conference room, ancillary offices, a lending resource library, and an audiology 
center. In addition, HPREC has partnered with Plan B Networks to meet the 
technology needs of area schools. Plan B Networks, providing systems 
integration consulting, is based out of El Paso, has a branch in Santa Fe, and will 
now have a branch based out of the HPREC office. 
 

A highlight of the new HPREC office is the state-of-the-art HPREC Training 
Center, which will be equipped with interactive technology to enhance 
professional development, as well as provide a model classroom to demonstrate 
the use of technology to enhance learning at all levels. In addition, the HPREC 
Training Center is designed to provide local schools with distance learning and 
professional development opportunities via ITV technology.  To date, HPREC has 
successfully connected in “live time” to Cimarron Municipal Schools, Clayton 
Municipal Schools, Roy Municipal Schools, New Mexico Highlands University, 
Clovis Community College, New Mexico State University, Colorado Community 
College On-Line, and Tanberg in Dallas, Texas. With this addition, HPREC has 
extended their office hours in order for Transition to Teaching participants and 
others to take advantage of evening classes offered through Clovis Community 
College. 
 

Thus, after a month or more of painting, construction, new carpeting, heating and 
electrical work, HPREC staff are settling into the new office.  Please feel free to 
stop by and visit us.  

Message from Executive Director … 
Stephen Aguirre 
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You are cordially 
invited to the HPREC 
#3 Open House at 
101 North 2nd in 
Raton on March 2, 
2006 from 3:00 pm to 
6:30 pm.  Come join 
us and tour our the 
new facilities and 
training room. 

Spring, 2006  
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 Virtual Math Manipulatives  By Shari Zimmer 

 

 
IDEA 2004 and NCLB have changed the way many educators view their jobs. Scientific-based research is a 
term most educators have become familiar with over the last few years.  Now more than ever, teachers are 
working diligently to align their curriculum with the standards to provide high quality educational experiences 
for their students.  Instructional delivery is “key” in accomplishing this task.  Using a variety of instructional 
technology tools is one way to differentiate instruction for the children who tend to be “at risk,”  while 
stimulating the thought processes of others.  The Illuminations website featured in this newsletter is 
sponsored by the National Council of Teaching Mathematics, and the National Science Foundation to help 
teachers provide visually stimulating instructional delivery opportunities for free. 

The Illuminations website allows a teacher to 
maneuver through a variety of virtual tools.  
You will notice the tabs to the left of the 
window that will take you through Lessons, 
Standards, Tools, and Web Resources.  This 
site will let you go to specific standards for 
the grade level.  

A teacher simply logs on to the website to find tools at their 
fingertips.  An LCD projector, hooked into your computer, 
allows you to project the image to use as a virtual 
manipulative tool.  The site is user friendly and provides 
written instructions on how to use the various manipulative 
tools.  You must enable JAVA in order for the virtual tools to 
work. 

Click on the standards tab 

#1 

#2 

#3 

#4 

Illuminations Website (NCTM)     http://www.illuminations.nctm.org 



 
National Library of Virtual Manipulatives (NSF)     http://nlvm.usu.edu 
 

 

 

 
The National Library of Virtual Manipulatives, supported by the National Science Foundation (NSF), is a 
site that offers hundreds of tools for K-12.  The following window shows their homepage.  To experiment with 
tools, click on the Virtual Library bullet.  The next image will be a window that will take you into any grade 
level you’d like for a specific strand.   
 

All you have to do is identify which strand and grade level you want to use.  You can print out an entire listing 
of virtual manipulatives for each grade level.  

 
If you want all the tools listed, click on the grade level blue box to the right of the index box heading.  This will 
pull up all manipulatives available for the grade level you selected.  Keep in mind …if you want something 
specific, you only need to click on the content strand and drag over to the grade level column you desire.  

 
. You can simply click on the math strand and scroll over to the correct grade level.  It may be helpful to print 
out each stand (and its virtual tools) and keep a copy in your lesson plan book.  This way you’ll be able to flip 
to the pages and quickly identify a large variety of free teaching tools that that can be used for creative 
instructional delivery options. 

 
You will also notice that the  “PROCESS STANDARDS”…the way math concepts are communicated are 
available for your perusal.  These are key factors in providing high quality instruction! 

 

This site is available to each student if they have access to the Internet at home.  It is a great way to provide 
opportunities for students to work together on grade level projects and illustrate their findings with virtual 
manipulatives.  It is a powerful way for them to communicate their understanding to their classmates.  

 

These tools allow a teacher to provide high 
powered lessons.  Students enjoy learning 
difficult content with the assistance of 
instructional technology tools.   

 

Please feel free to call Shari Zimmer at 
HPREC if you have any questions regarding 
these sites at 445-7090 or email 
szimmer@hprec.com  
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Continued from page 2 

How You Teach Is More Important Than What You Teach! 



Three Tiered Licensure Training Project By Midge Graham 

PAGE 4 

In the High Plains REC area, as many as 35-40 teachers plan to prepare and submit dossiers in February 
and June, for licensure advancement.  This year, more than half of those will be Level II teachers who hope to 
advance to Level III in the new system.  This is representative of the pattern statewide.  Congratulations to 
Karyn Hall, Longfellow Elementary School, who submitted her dossier in November and was 
successful at meeting standards for all strands!  Workgroups are established in most districts now and 
are working in planned workshops and technical assistance sessions as needed. 
 

The 3TLS training project continues to serve districts and teachers/administrators by providing training 
modules from the project MENU, as needed.  In most districts, training sessions were held for new teachers 
and administrators.  Updated training has been provided for Boards of Education in the region and technical 
assistance has been provided with a variety of training goals, including the development and evaluation of 
professional development plans, use of indicators for teacher performance evaluation, administration of 
growth plans, etc.   
 

At the state level, data collection is taking shape and important 3TLS reports will be made to the legislature.  
According to Dr. Jim Ball, plans are to request additional funding for continuance of the training project.  For 
more information or to request specific training, contact Midge Graham at 505-278-2188 or 505-643-7557 or 
through the High Plains REC. 
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The Council of Administrators of Special Education 
This online resource supports programs and services designed to improve the learning experience for students with 
special needs. 
http://www.casecec.org/  
Urban Special Education Leadership Collaborative 
This international organization provides an online network for special education professionals to network and promote 
new best practices for students with learning disabilities. 
http://www.edc.org/collaborative/  
Parent Advocacy Coalition for Educational Rights 
The PACER Center was created for parents by parents of children and youth with special education needs. This site 
offers a wealth of resources to help parents ensure their child has access to quality education services. 
http://www.pacer.org/  
The Council for Exceptional Children Catalog 
This collection of resources will help educators teach students with special needs the life skills they'll need to make 
the successful transition to life after school. 
http://www.cec.sped.org/bk/catalog2/ 
transition-lcce.html 
Center for Special Education Finance (CSEF) 
This group conducts research aimed at promoting and improving special education programs and funding sources. 
http://csef.air.org/index.php 
Office of Special Education Programs 
OSEP is dedicated to improving the education of children and youth with special needs. This online resource provides 
leadership and resource information about available programs.  
http://www.ed.gov/about/offices/list/osers/osep/index.html  
National Center on Secondary Education and Transition  
The NCSET is a partnership of six organizations providing secondary education and transition resources.. 
http://www.ncset.org/  
The Transition Coalition 
The Transition Coalition provides professional development skills forums and new best practices for special education 
teachers at the secondary school level.  
http://www.transitioncoalition.org  
 

Special Education Transition Web Resources 
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Upcoming Professional Development Activities 

 To register for these workshop/trainings or for more information,  
please call Hollie at HPREC (445-7090)  

Space Limited ~ Register Today! 

Learning is ... great!! 

Special Education Directors’ Regional Meeting         
Date:            Tuesday, February 7, 2006 9:00—11:30 am             
Location:       HPREC Training Center, 101 North 2nd in Raton 
 

Transition Team Regional Meeting         
Date:            Tuesday, February 7, 2006 1:00 pm               
Location:       HPREC Training Center, 101 North 2nd in Raton 
 

PBS Team Training                             
Don’t miss out on this hands-on workshop designed for school-based PBS teams. 
Presenters:   Dana Stoltz Gray, Shari Zimmer, Mary Lloyd, and Elisabeth Nixon-Petersen 
Date:            Friday, February 10, 2006                
Location:       HPREC Training Center, 101 North 2nd in Raton 
Audience:   PBS Teams, PBS Coaches, Administrators  
 

DIBELS Summit 2006         
HPREC’s annual national conference for DIBELS researchers from across the country. 
Date:            March 9—11, 2005                              
Location:       Tamaya Resort, Santa Ana Pueblo 
Audience:   DIBELS researchers & advanced implementation teams 
 

Fun With Scissors & Graphic Organizers                                  
Don’t miss out on this hands-on workshop designed for school-based PBS teams. 
Presenter:   Elisabeth Nixon and Shari Zimmer 
Date:            Date To Be Announced                         
Location:       HPREC Training Center, 101 North 2nd in Raton 
Audience:   K-12 Educators, administrators, & TTT participants 
 

Regional Math Training                              
Presenters:   Lisa Snow and Shari Zimmer 
Date:            Friday, April 21, 2006                 
Location:       HPREC Training Center, 101 North 2nd in Raton 
Audience:   K-12 Educators, Administrators, & TTT participants 
 

PBS Coaches’ Training                             
Hands-on workshop designed for PBS coaches. 
Presenters:   Dana Stoltz Gray, Shari Zimmer, and Elisabeth Nixon-Petersen 
Date:            Friday, April 28, 2006                 
Location:       HPREC Training Center, 101 North 2nd in Raton 
 
 

Trainings To Be Held At HPREC, Times To Be Announced, Call for Information    
AIMSweb Training               
Pre-AP & AP Workshops         
TIEnet and S.A.T. for Administrators                   
TIEnet and S.A.T. for All Teachers 
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Everybody is Talking About TIEnet     By Dana Stoltz Gray 

After months of development, TIEnet is now available for all teachers and administrators in the High Plains 
Regional Education Cooperative region.  TIENET is a management system designed to address the entire 
instructional process including student assistance teams, evaluation and assessment, Special Education 
eligibility, IEPs, Special Education case management, Section 504, and more.  
 

Beginning in May, 2006 special education directors, special education teachers, HPREC ancillary staff, and 
HPREC program staff began a multi-month process to develop a user-friendly, comprehensive, and legally 
compliant process to assist all educators with instructional processes. After multiple meetings, many hours of 
work in developing and fine tuning the forms and processes, completion of a comprehensive review and 
feedback process, and ensuring internet access in schools, TIEnet became available on January 11, 2006 to 
area school educators.   

 

On January 11 – 13, 2006, special education directors, special education secretaries, special education 
teachers, and ancillary personnel began Phase I of TIEnet training. Since the training, these professionals are 
working with TIEnet, entering student information, developing IEPs, and more.  Phase II of TIEnet trainings 
will begin in February. Phase II will involve advanced trainings for those involved in Phase I trainings, as well 
as training for all principals, superintendents, and regular education teachers. Once trained, schools will have 
a web-based system to use with all students to document intervention effectiveness and assist with special 
education and Section 504. The goal is for all teachers and schools to use TIEnet to ensure seamless, 
effective, and legally compliant processes.  Watch for more trainings coming soon.  If you have any questions 
or would like more information, please feel free to contact High Plains Regional Education Cooperative. 

 

Watch for upcoming trainings for administrators and teachers! 

 
An Occupational Therapist’s Perspective on TIENET       
By Martie Lockwood 
Over the last few years, HPREC has attempted to unify Region #3 through the use of a central data base that 
could be easily accessed by ancillary staff, teachers and administrators.  We were very fortunate to have 
been approached last spring by the representatives from TIENET. I was impressed with the initial 
presentation, but past experience with other companies had left me very skeptical that the company would 
actually follow through with their promises to us. I am pleased to report that they have not only kept their 
promise to allow us to develop a program that is specific to the needs of Region #3, but they have also 
provided excellent representatives who have been extremely helpful in training all personnel.  

Because each department (occupational therapy, physical therapy, speech therapy, etc.) had the opportunity 
to write their portion of the program, our assessment tools, daily documentation, summaries and parent 
contacts are easily accessed and uniform.  When these documents are printed, they are well organized and 
easy for parents to read.  

One of the best features of the TIENET program is that local administrators are being trained in making 
changes as the need arises.  We know that state and federal  regulations are constantly changing and now 
we have the means to stay current  and in compliance.   

I would like to take this opportunity to thank the HPREC staff and the TIENET representatives that have 
worked tirelessly in an effort to complete the TIENET  program and get teachers, ancillary and administrators 
on line. I have no doubt that this is a program that will serve us well now and in the future.   
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A school is only as good and successful as the 
teachers that are in it. I would like to thank Mrs. 
Martinez English). Mr. Mann (History), Mrs. 
Overberger ( Science), Mr. Overberger ( Math), 
Mr. David Wright ( computers), Mr. Baca 
(Vocational Technology), Mrs. Ivey (K-2), Mrs. 
Hartley (3-4), Mrs. Ray (5-6), Ms. Garcia (Title I / 
Elementary P.E.), Mrs. Costa (Aid), Mrs. Goret 
(Aid), Mrs. Scott (Special Ed). I truly appreciate 
the hard work and dedication that you put forth in 
order for our students to be prepared and 
successful in or society. 

Thanks to all of the other schools within our area 
for their support and thoughtfulness.              
~Rick Hazen, Superintendent                         
Roy Municipal Schools 
 

A HUGE thank you to everybody who helped on 
the TIEnet project and brought our vision to 
reality. Thank you to all the special  education 
teachers, special education directors, and 
ancillary staff who provided feedback and 
guidance in the development of TIEnet for region 
#3 area schools.  I would also like to thank Martie 
Lockwood, HPREC Occupational Therapist, for 
her hours and hours of working with TIEnet to 
work out the glitches.  Martie’s dedication and 
commitment has made TIEnet more user-friendly 
for all of us!   Finally, a very special “Thank You” 
to Elisabeth Nixon-Peterson, Shari Zimmer, and 
Mary Lloyd (HPREC program staff) for their never-
ending support and tireless hours in bringing the 
TIEnet project to fruition.  

~Dana Stoltz Gray, Director of Programs, 
HPREC #3 

Many thanks and much appreciation goes out to 
Kathy Owensby for her tireless dedication to the 
Read Naturally program.  She has worked many 
hours to organize trainings, secure volunteers, and 
implement the program in Des Moines.  Kudos to 
Kathy! 

~ Jaynee Burchard, Superintendent 
Des Moines Municipal Schools 
 

Many thanks to the HPREC staff for all their efforts 
on behalf of region #3 schools and staff.  Special 
thanks to Midge Graham for her tireless efforts with 
the 3-Tier Licensure Dossier process and to Bob 
Anglin for his excellent coaching, modeling, and 
consulting with regional teachers participating in 
the HPREC reading project. A special thanks to 
Dana Stoltz Gray for her help and persistence in 
getting the DIBELS measures established in region 
#3...we are way out ahead of the rest of the state in 
using this data to drive our educational decision-
making at the school level.  THANKS to all Clayton 
District administrators for their efforts on behalf of 
students and staff so far this year … great job!!  
Lastly, thanks to Stephen Aguirre for his leadership 
and vision in bringing the HPREC and Region #3 to 
where they are today.  He keeps us on the cutting 
edge of education, technology, and more.  Keep up  
the good work! 

~Jack Wiley, Superintendent Clayton Municipal 
Schools 
 

Its hard to believe that half of the school year has 
passed. It is time to begin another semester, so 
that means starting off with short cycle assessment 
tests. These will identify each students progress 
towards standards and benchmarks for their level 
of education. 

We are in the process of remodeling the Home Ec. 
Cottage to house our school based health clinic. 
The health clinic is operating in the coaches office 
for the time being. Thanks to Deanna Walker for all 
of the hard work in making this project a success. 

Congratulations to the Roy FFA chapter for 
receiving a $2500.00 grant to improve the Ag. farm. 
The Roy FFA chapter is preparing for the spring 
competitions and are excited to begin those 
adventures. We are very appreciative of the 
sacrifices that Mrs Smith has made in order to 
make this program a success. 

APPLAUSE!   APPLAUSE!   APPLAUSE!  

Raton Main Street Group                              
Key Presentation Ceremony on Feb. 7, 2006 



 
 
 
 
 

 
 

 
 
 
 
 
 
 
 

 
. 
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 HPREC  
 Board of Directors 

Rick Hazen, Roy—Chairman 

Zita Lopez, Springer—Vice-Chairman 

Jack Wiley, Clayton—Secretary 
Dr. Annette Johnson, Cimarron 

Jaynee Burchard, Des Moines 

Dr. Kaye Perry, Maxwell 

Tim McCoy, Mosquero 

Bill Walz, Raton 

  HPREC Staff 
R. Stephen Aguirre, Executive Director 

Dana Stoltz Gray, Director of Programs 

Paul Romero, Educational Technologist 

Elisabeth Nixon-Peterson, Ed./Program Specialist 

Shari Zimmer, Ed./Program Specialist 

Mary Lloyd, Program Coordinator 

Lisa Gonzales, Business Manager 

Hollie Fish, Program Assistant 

Esther Torrez, Human Resources 

Rachael Padilla, Admin. Assistant 

Bob Anglin, Reading Specialist 

Midge Graham, 3-Tier Consultant/TTT Advisor 

Michael Johnson, Technology Support 

Carmen Valerio, Custodian 

HPREC Awarded RUS Grant 

Representatives from Senator 
Bingaman, Senator Domenici, and 
Congressman Udall’s offices joined 
Ernie Watson from the USDA in 
congratulating R. Stephen Aguirre 
and the HPREC staff on receiving 
an RUS grant in the amount of 
$454,668 to be used to develop 
connectivity to area schools. 

Ms. Siefertson’s 3rd Graders 

Ms. Beard’s Second Graders 



Here are some tricks that will help you WOW and impress friends and family alike.   

Want to delete files in one step, without the Recycle Bin?  Just hold down the Shift key while deleting a file 
permanently.  Be careful though, there is no second chance with this choice, but it is a one step way to be rid 
of the file.  Need a speedy way to restart Windows without rebooting your computer?  Hold down the Shift key 
as you select OK in the Shut Down Windows dialog box.  Want to streamline your system tray?  (That is the 
gray bar at the bottom of your screen and holds the icons for the programs that start up when you boot your 
computer.)  You control this with the System Configuration Utility.  Simply open the Run command (Start, 
Run) and type in “msconfig”.  Go to the Startup tab and unselect programs that you do not need.  Be careful 
here, not to uncheck program applications that you might need. 

Ever noticed a friend’s computer that had a pretty picture or neat graphic as the desktop wallpaper?  Well, 
now you can have something lovely to look at everyday too.  In Win98, click Start>>Settings>>Control Panel, 
double click Display, then Background.  Check the scroll box under Wallpaper.  If you see an image on a Web 
site that you would like to look at everyday, you can have that too.  Right-click on the picture, and click Set As 
Wallpaper.  If the image does not fill the desktop, look for Position in the Display Background area, above.  In 
this area, you can stretch, center, or tile a wallpaper image. 

Can’t see the words on your websites too well?  In Internet Explorer, you can make the text larger (or smaller) 
by clicking the View menu and then selecting Text Size.  To adjust the amount of hard disk space used for 
temporary Internet files, select Tools>>Internet Options>>Settings.  You can take a look at the files here too.  
To make sure that you are viewing the latest version of a website and not the one saved on your drive, press 
F5 to refresh your page. 

Did you ever wish your desktop icons were bigger or even smaller?  You can resize them by right-clicking on 
a blank area of your desktop, and then selecting Properties.  Choose the Appearance Tab, and scroll to Icon 
under the Item pull-down menu.  Next, change the size up or down, and click OK to save the new setting.  
You can also rename your icons very easily.  Rename it by right clicking the icon and selecting Rename 
(works with file names in Explorer too!). 

Do you have a Windows password box that pops up every time you start your computer?  If you are the only 
user or if you don’t want to use a password, you can be rid of this little annoyance fairly easily.  Go to 
Start>>Settings>>Control Panel and double click on the Passwords icon.  Click the Change Passwords tab 
and select the Change Windows Password button.  Clear all three fields and select OK.  Exit out of both 
windows. 

Would you like to add a quote to each of your e-mails, automatically?  This is the equivalent of a signature.  In 
Microsoft Outlook, from the Tools pull-down menu, select Options. Click the Mail Format tab and select the 
Signature picker.  In the new window, click on New and enter a name for this particular signature.  You have 
the option to create more than one signature or quote as the case may be, and select the one you want to 
use as you create an e-mail.  Click Next and enter the text to include.  Click Finish and you are done.  Now 
you may choose which one you want to use as your Default.  When you create new mail, the text will 
automatically appear.  If you want a different quote, select the Signature icon in the new message toolbar and 
pick the one that is appropriate for the person receiving the e-mail. 

In Outlook Express, on the Tools pull-down menu, select Options.  Click the Signatures tab and click the New 
button.  Enter the desired text and click the Set as Default if you want it as the preferred signature or click the 
Advanced button to assign it to a specific e-mail account.  Add your signature to specific e-mails from the 
Signature Option on the Insert pull-down menu. 

We hope at least one of these “tricks” will be added to your techie bag of tricks.  See you next time! 

Techie Tricks to WOW Your Friends  By Mary Lloyd 
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All of the top achievers I know are lifelong learners … looking for new 
skills, insights, and ideas.  If they’re not learning, they’re not growing 

… not moving toward excellence.  
Denis Waitley 
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Professional Learning Communities  By Elisabeth Nixon-Peterson 

A professional learning community is a structure that provides an opportunity to develop the capacity of school personnel 
to function as a learning organization, as a learning community of continuous inquiry and improvement.  

 In their book, Getting started: Reculturing Schools to Become Professional Learning Communities (2003), Richard and 
Rebecca DuFour, along with Robert Eaker, discuss the role of change and the cultural shifts that occur when 
transforming schools into professional learning communities.   

“Professional learning communities are our best hope for reculturing schools.  A common 
belief is that changing the structure of schools – how they are organized – is the primary way 
to change behavior.  But changing the structure of schools is not enough.  Changing the 
structure without altering the belief system will not produce fundamental changes” (Eaker, 
DuFour, and DuFour, 2002, p. 9).  

When looking to change a school culture so that it shifts into a professional learning community, many 
elements need to be addressed, including: collaboration, development of mission, vision, values, and 
goals, a focus on learning rather than teaching, a focused school improvement plan, celebration, 
persistence, and leadership.  

“Culture is the total sum of interactions among community members and the beliefs that they 
bring to those interactions, the creation of such a culture means establishing norms and 
practices that lead to trust, mutual respect, continuous improvement, team-focused 
collaboration, clarity of thought, the candid expressions of views, and interpersonal 
accountability for the fulfillment of commitments” (Sparks 2003, p. 2).   

Peter Senge’s 1990 book, The Fifth Discipline, shared with corporate America the idea of the learning 
organization “where people continually expand their capacity to create the results they truly desire, 
where new and expansive patterns of thinking are nurtured, where collective aspiration is set free, and 
where people are continually learning how to learn together” (p.3).  As educators began to explore the 
challenges of reform, the idea of working collaboratively, of learning from one another, moved into the 
arena of education and became known as “learning communities.”  

Historically, American public schools were organized around the concepts of the factory model; where students were 
taught the basic skills and simple facts they needed for industrial jobs.  Large buildings enclosed labyrinths of 
classrooms where students sat in neat rows with the teacher up front, learning just enough to work at jobs they would 
keep for much of their lives.   

  “The factory model is woefully inadequate for meeting the national education goals of today--
goals that call for all students to master rigorous content, learn how to learn, pursue productive 
employment, and compete in a global economy.  If educators are to meet these challenges, they 
must abandon an outdated model that is contrary to the findings of educational research and 
best practices of both schools and industry, and common sense”  (DuFour & Eaker, 1998, p. 3).   

Within this new model, all students will be held to higher standards of learning, links between students and their 
communities will be strengthened, and roles will change. New relationships will be forged between administrators and 
teachers, teachers and students, the school and community.   “Professional learning communities rest on a foundation of 
four building blocks or pillars that support the school and give direction to the people within” (DuFour & Eaker, 1998, p. 
57).    

Professional learning communities create a broad structural framework for individual student achievement and overall 
school improvement.  This structure supports teachers and administrators, encouraging collaboration and inquiry into 
best practices for teaching and learning.   Professional learning communities have the following six characteristics: 

Shared mission – Why do it in the first place?  Why do we exist? What are we here for?  

Vision – What do we hope to become?  

Values – How must we behave in order to make our shared vision a reality?   

Collective Inquiry – Questioning the status quo, seeking new methods, testing these methods, and reflecting on 
results. 

Collaborative teams – A group of collaborative teams that share a common purpose. 

Action orientation and experimentation – Aspirations are turned into actions and visions into reality, a willingness 



Continuous improvement – Each member of the community is engaged in considering key questions; What is 
our fundamental purpose? What do we hope to achieve? What are our strategies for becoming better? 

Results orientated – Ongoing assessment of the characteristics is based on results not intentions. 
 

While the PLC focuses on achieving these characteristics, they also continually ask three critical questions (DuFour, 
Eaker, & DuFour, 2002).  (a) What do we want students to learn?  (b) How will we know if they have learned it? (c) What 
are we going to do if they have not learned it? 

Schools that function as professional learning communities are always characterized by a collaborative culture in which 
teachers no longer work in isolation; the staff work together and participate in decision-making.   All members of the 
community are called upon to be contributing members of a collective effort to improve the school’s capacity for helping 
all students learn at high levels (Eaker, DuFour & DuFour, 2002).   

In order for the Professional Learning Communities to function successfully, the learning community must: 

• Develop shared vision, mission and values to guide them along the process of changing the school culture. 

• Form collaborative teams that engage in collective inquiry, action orientation and experimentation. 

• Develop a commitment to continuous improvement through a focus on results. 

• Move away from the model of a traditional school, where teachers work in isolation, to a culture of collaboration 
where the universal agreement is that children learn at different rates.  Also that time and support must be planned 
and given to support all children, and that the strength in reaching this goal lies in the teachers themselves. 

• Involve the community in teaching them about the students. 

The seeds of school improvement and school reform must be planted and 
cultivated.   Professional Learning Communities are not the silver bullet to success 
but do provide an infrastructure for change to begin.   

 

References: 
Eaker, R., DuFour, R., and DuFour, R. (2002). Getting started: Reculturing  

     schools to become professional learning communities.  Bloomington, Indiana:  

     National Educational Services 
 

Eaker, R., Karhanek, G., DuFour, R., and DuFour, R.   (2004). Whatever it takes:  

     How professional learning communities respond when kids don’t learn.   

     Bloomington, Indiana: National Educational Services 
 

Senge, P. (1990).   The fifth discipline: The art and practice of the learning  
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Maxwell Schools PBS  
The year started at Maxwell Schools, the PBS 
team taught all students appropriate behaviors in 
the classroom and around campus.  We also 
began giving positive BEARy Good! slips to 
reinforce students who had positive behaviors, 
such as responsibility, courtesy, safety and 
respect.  Students can then win a weekly drawing 
for prizes.  The students seem to be grasping the 
positive ideas and are much more well behaved 
this year, resulting in greatly reduced disciplinary 
referrals.  

Positive Behavior Support Across the Region ... 

Springer Schools PBS 
Springer students show their Devil Pride with Positive 
Behavior Support bulletin boards showing Preparation, 
Respect, Integrity, Dedication, and Excellence. 

Des Moines Schools PBS 
A sign in front of the Des Moines School is there to 
remind students to "Demon Up" with respect, 
responsibility, and safety. 
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Cimarron High School’s PBS program is up and running.  We are the RAMS:  Responsible, Academic, 
Models of Courtesy and Safe.  Students know what rules fall under each of these categories.  If they violate a 
rule, staff members “re teach” the rule in some way.    The handbook is also organized using RAMS. 

Teachers and staff members reward students for positive behavior.    We give courtesy cards and do a 
courtesy drawings every month.  The winners of the courtesy drawings get an off campus lunch with Mrs. 
Coppedge. 

We also give out “Ram Bucks” to students who are exceptional at following the RAMS rules.  At the end of the 
semester, the students who have Ram Bucks can shop at the Rams Store for things like CDs, DVDs, jewelry, 
CD players, headphones, gift cards, etc. 

When we do have rule violations and discipline problems, we have a system in place where each teacher has 
a partner teacher to help with the situation.  This has worked well because sometimes a student just needs a 
change of environment to get his/her behavior back on track. 

So far, RAMS has worked wonderfully.  We have very few discipline problems and students are happy in a 
positive environment. 

Longfellow Elementary 
Positive Behavior Support has taken hold at 
Longfellow Elementary in Raton.  The school 
has seen a positive change in student behavior.  
The school focus has been in the cafeteria and 
lunch line.  Everyone is please with the Super Bee 
and token rewards in these areas. 

Longfellow Elementary’s hardworking PBS Team:  
(left to right) Kelli Gabriele, Andy Ortiz, Carmen 
Valerio, Marian Ray, Nancy Gomez, and Shawna 
Williams.  Not pictured is Toni Lea Fulmer.   

More Great PBS Happenings ... 

Cimarron Schools 

HIGH PLAINS REC #3  
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PBS in Region #3 ~ Great Things Are Happening! 

One of the things that Alvis is doing with the PBS is 
the Caught Being Good Coupons.  At the end of each 
month a child from each grade level is drawn and 
receives a 3Bees t-shirt.   

Kiser Elementary saw and enjoyed “visions of sugar plums” during 
the Christmas season.  When staff “caught a student being good”,  
the student was rewarded by getting to clip a sugar plum (candy) off 
of a Christmas wreath.  Each teacher and the office had a wreath of 

candy in his/her room, which 
was a motivating reminder 
for the students. 

Kiser students also worked 
toward filling a gallon marble 
jar.  If the marble jar had 
been filled, the whole school 
would have celebrated with a 
gingerbread house building 
party.  Alas, the jar wasn’t 
completely filled, so we didn’t 
go into construction.  Maybe 
next year!! Clayton Schools 

Columbian 
Elementary 

To reinforce positive 
behavior in the 
lunchroom Columbian 
Elementary is awarding balloons to the best behaved class in the lunchroom.  
The class with the most balloons for the week becomes the “Super Class” for 
the week.  Being the “Super Class” allows the class to eat first the following 
week, they get to hang the ribbon outside their classroom, and receive a class 
reward from their teacher.  This incentive has worked so well that on some days 
two classes may be chosen.  Congratulation Super Classes!!                         



As districts look for a 
scientifically-based, efficient 
short-cycle assessment, 
AIMSweb®  may provide a 
needed answer.  Similar to 
DIBELS, AIMSweb® is a 
formative assessment system 
that ‘informs’ the teaching and 
learning process by providing 
continuous student performance 
data and reporting. This 
assessment system facilitates 
evidence-based evaluation and 
data-driven instruction for 
students kindergarten through 
eighth grade. 

AIMSweb utilizes Curriculum-
Based Measurement (CBM); an 
approved and standardized 
assessment practice based on 
over 25 years of scientific 
research.  The system provides 
CBM testing materials for: 
• Oral Reading Fluency 
• Reading Comprehension 
• Early Literacy 
• Early Numeracy 
• Math Computation/Math 

Facts 
• Spelling 
• Written Expression 

AIMSweb's 3 Tier assessment 
model combines CBM with web-
based data management and 
reporting applications.   
Together, these components 
provide a pro-active, evidence-
based solution for universal 
screening, strategic 
assessment, determining special 
services eligibility, and progress 
monitoring.  
 
High Plains REC #3 will be 
providing AIMSweb training in 
Spring 2006. Watch for the 
brochure coming soon! 

You are cordially 
invited to the 

 

HPREC #3 Open House 
  

101 North 2nd  
Raton, New Mexico 

March 2, 2006 
3:00 pm to 6:30 pm.  

  
Come join us and tour our 

the new facilities and  
training room. 
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Got a Short-Cycle Assessment? 

HIGH PLAINS REC #3  

Did you know?   
 

Since June 2005, over 1950 educators have participated in professional development activities 
sponsored by High Plains Regional Education Cooperative. 

 
The Power of Team  

"The flightless fairy penguin 
of Australia stands less than 
a foot tall and is clumsy on 
land, where the fox is its 

natural enemy. Alone, one 
penguin wouldn't survive for 
long. So, after each day in 

the water, they gather where 
the surf meets the shore, 

waiting until the last penguin 
joins them. Then shoulder to 
shoulder they march up the 
beach to their burrows. They 

support each other.  
They rely on each other.  

And everyone, except the 
fox, wins.” 
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